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ACTION: ACCESSING THE ADMINISTRATORS' PORTAL

STEP 1:

To navigate to administrative access to add, edit or view current bids connect type the following link
into your browser: Irwravendorportal.com/login/.

Once there, you will see this screen requesting your username and password.

& > C | ® Notsecure | Irwravendorportal.com/login/page/?open=1

@ PROCESSWire

Admin  Login

Username Password

© Forgot your password?
@ Home

STEP 2:

Enter the following information:
Username: Irwra
Password: 11clearwater

*Please note, these logins can be customized for different users.
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STEP 3:
Next, you will land on the following page:

< C | ® Irwravendorportal.com/login/page/?login=1
(p) PROCESSWITE
Pages © Irwra - Successful login
Find
Recent Pages
s Home 5
Export Vendors Vendor Portal

From this “Home” page screen for administrators, you can complete the following actions:

1. View a listing of all active bids
2. Post, publish and send bids to vendors

3. Edit bids
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ACTION: VIEWING ALL ACTIVE BIDS
(WHILE LOGGED IN AS AN ADMINISTRATOR)

STEP 1: VIEWING ALL ACTIVE BIDS (WHILE LOGGED IN AS AN ADMINISTRATOR)

To view all active bids, hover over the “Home” tab until you see the menu options “View” and “New” to
the right of this tab. Once these options appear, select “View.”

Your screen should appear as follows:

Pages : @ Irwra - Successful login
Find
Recent Pag eS
s ' Home & New
Export Vendors Vendor Portal
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STEP 2: VIEWING ALL ACTIVE BIDS (WHILE LOGGED IN AS AN ADMINISTRATOR)

Once you have selected and clicked on the “View,” tab you will be directed to the following page,
“Current Solicitations,” where you can view a complete list of all active bids:

SOLICITATIONS e e &  HELPFULLINKS

Become a Vendor »

LRWRA-18-002 EQUIPMENT TRAILERS (SMALL) =n LRWRA Main Site »
BBl submission Deadline: 200 pm, Mar 1,208

LRWRA-18-001 GAS LEAK DETECTION SENSORS =1
m Submission Deadline: 230 pm, Mar 6, 2018

LITTLE ROCK
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ACTION: VIEWING BIDS BY TYPE

STEP 1: VIEWING BIDS BY TYPE
From “Current Solicitations” page, you can also view current bids by type.

Simply click on one of the options in the menu indicated by the arrow to select a bid opportunity by its
classification as a Bid, RFP, or RFQ.

ALL BIDS:

CURRENT SOLICITATIONS

SOLICITATIONS e s 65 s &  HELPFULLINKS

Become a Vendor »

LRWRA-18-002 EQUIPMENT TRAILERS (SMALL) [ e | LRWRA Main Site ,

BB submission Deadline: 2:00 pm, Mar 1, 2018

ITRWRA-1R.0N1 CAS | FAK NFTERTINN SFNRNRS

BIDS

CURRENT BIDS

BIDS VEW. Al B REPs BECs & HELPFUL LINKS
Become a Vendor »

LRWRA-18-002 EQUIPMENT TRAILERS (SMALL) ekt "

Bl  submission Deadline: 2:00 pm, Mar 1, 2018 _ o

LRWRA-18-001 GAS LEAK DETECTION SENSORS =R

BBl submission Deadiine: 2:30 pm, Mar 6, 2018

LITTLE ROCK
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RFPs

8 LRWRA Vendor Portz X X ’\5 LRWRA Vendor Port= X \5 LRWRA Vendor Port= X | [ INVITATIONTOBID X | {§ LRWRA VendorPortz X \n Yahoo X | ly; Proofreading Marks - X
& c l@ Irwravendorportal.com/vendor-portal/solicitations/rfps/

LITTLE ROCK

SOLICITATIONS. LOG ouT

ONE WATER.
ONE FUTURE,

'GURRENT RFPS

RFPS VIEW: Al Bids RFPs RFQs 00 HELPFUL LINKS

Edit Profile »
LRWRA-17-023 LAWN MAINTENANCE SERVICES

m £ February 28,2018 procurement@lrwra.com

CONTACT US

Ifyou have any questions, please

contact:
Amber Yates
RFQs
(6 LRWRA Vendor Port: X \75 LRWRA Vendor Porte x | [ INITATIONTOBID X §§ LRWRA Vendor Port= x | I Yahoo x|l Proofreading Marks - X ]

& LRWRA Vendor Port= X
& (¢ \ @ Irwravendorportal.com/vendor-portal/solicitations/rfqs/

LITTLE ROCK
¢ 3§ Water Reclamation SOLICITATIONS

‘GURRENT RFQS

RFOS VIEW: Al Bids RFPs RFQs e HELPFUL LINKS

Edit Profile »
LRWRA-18-004 COMMERCIAL INSURANCE BROKER

m B3 May31,2018 & procurement@Irwra.com

CONTACT US

-

Ifyou have any questions, please
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To navigate back to the complete list of bids after viewing bids by type, click the “Solicitations” button in
the upper right hand corner of your screen.

&mmm SOUCHATONS
:

CURRENT BIDS

BIDS VIEW: AN Bioz REPs REQs e HELPFUL LINKS
Become a Vendor »
LRWRA-18-002 EQUIPMENT TRAILERS (SMALL) [ | LRWRA Main Site N

BBl submission Deadline: 2:00 pm, Mar 1, 2018

FROM THE “"CURRENT SOLICITATION” HOMEPAGE, YOU CAN ALSO:
-Logout

SOLICITATIONS VW A1 B 7P REs ® HELPFUL LINKS

Become a Vendor »
LRWRA-18-002 EQUIPMENT TRAILERS (SMALL) = T ,
LITTLE ROCK
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-View heIpfuI Imks (we currently have no content for this)

CURRENT SOLICITATIONS

SOLICITATIONS -0
LRWRA-18-002 EQUIPMENT TRAILERS (SMALL)

BB} submission Deadline: 2:00 pm, Mar 1, 2018 _
LRWRA-18-001 GAS LEAK DETECTION SENSORS =

IEBN submission Deadline: 230 pm, Mar 6, 2018

P d HELPFUL LINKS
Edit Profile »
LRWRA Main Site >

-Edit vendor profiles (if needed)

CURRENT SOLICITATIONS

SOLICITATIONS o

LRWRA-18-002 EQUIPMENT TRAILERS (SMALL)
BB} submission Deadline: 2:00 pm, Mar 1, 2018

LRWRA-18-001 GAS LEAK DETECTION SENSORS
m Submission Deadline: 230 pm, Mar 6, 2018

& HELPFUL LINKS
Edit Profile ,
LRWRA Main Site >

LITTLE ROCK
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Keep in mind, a public view of all current bids is also available through the current website. Click on the
“Business Center” tab on the main navigation of the current Irwra.com site, and select “Vendor Portal”
from the dropdown.

V & trwray - x (B LRWRAVendor Port= x '( §§ LRWRA VendorPorts x ' [} INVITATION TOBID. (& LRWRA VendorPortz x '\ I Yahoo x ) B Vendor Portal
& C | ® www.Irwra.com/vendorportal
=
y Water Reclamation
Authority s reves:.
Home Maps Stay Connected Customer Information About Us
Vendor Portal Vandar orst
. Vendor Portal
The Little Rock Water Reclamation Authority Vendor Portal is designed to help vendors stay up to date on upcoming items for bid by Little Rock _ ;
Finandials

required to view our bid items, vendors are encouraged to register and create a profile. During the profile creation process, vendors can subscr
subcategories of their specialization. After the vendor profile is created, if a bid item is added or modified that matches the vendor's subscribed

Capital Projects & Improvements
email notification. Vendors will not rect

notification if the bid item does not match their subscribed category/subcategory.

Click here to | ofile Where Does Your Money Go?

Click here t

If you have any questicns, please contact:
Amber Yates
501-688-1450

proc

Current Bids

All solicitations have been moved to our new vendor portal.

View Current Solicitations

From this page, click on the link “View Current Solicitations.”

Current Bids

All solicitations have been moved to our new vendor portal.
View Current Solicitations €——

LITTLE ROCK
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ACTION: ADDING BIDS

STEP 1: ADDING BIDS

To add a new bid, login to the Administrators’ Homepage. You may add bids from the “Home” tab or the
“Vendor Portal” tab. The steps are the same once you make a selection.

& C | ® Irwravendorportal.com/login/page/?log
(p) ProcESSWire =
Pages @ Irwra - Successful login
Find
Recent pages
Access y H o
ome 5 View [{E
Export Vendors Vendor Portal
OR
€& > C | ® Irwravendorportal.com/login/page/?open=1

(P) PROCESSwire

Pages Admin
Find Pages
Recent
Home 4
Access Vendor Portal 1 view (23
Export Vendors Site
LITTLE ROCK

Water Reclamation
J Authority sx wevss:.



STEP 2: ADDING BIDS

After you have selected the “New” option from either tab, you will be directed to a new screen asking
you to name your bid. Name your bid based on the approved organizational format, and click “Save.”

<« C | ® Notsecure | Irwravendorportal.com, t * O :
(P) ProceSSWire
Tree
Add New [ save |
Recent
Solicitation
& Access Title
Export r
Name & Ok *
1
ar

STEP 3: ADDING BIDS

Once you have named and saved your bid, you will be directed to this screen. At this step in the process,
you will be allowed to enter all relevant information about your bid, including the publish dates (when
these bids are active and viewable by the public and vendors), the opening date, bid type, contact
information, etc. Please note, that with this system, you may select multiple categories in which your bid
may fall.

C | @ Notsecure | Irwravendorportal.com

(@) ProcESSWire

© Created page ftest- 1 using template: bid o

Tost 1 e

Export Vendors
Solicitation Name ~ Publish From Date * Publish Until Date

Test 1 February 21, 2018 February 22, 2018 =

Opening Date * Bid Type * Contact*

February 21, 2018 RFP » procurement@irwra.org

Categories

Subject Line *

LITTLE ROCK

Water Reclamation
J Authority sx wevss:.




When adding documents, you must add a description to your document or it will not populate on the
bid page. This will serve as the title of the document once users click through to see all information
available about the bid.

NIB roravens: x )/ 1) ioepsge Ter x 3 Expon Verdon

€ D C (DNelw(ute rmrmmrpovu!wm

# Automotive Parts and Supplies, and Shop Equipment and Supplies: Utility Beds L ]
Subject Line *

Bid Opportunty 123

Email Message *
Nomal - |Sties +|B I L=y e MEOMEQ G B Y| Bsouwe

We are pleased to announce this bid opportunity

body p

& Documents

adding_new_bids_step.png &4 k5 L
Your bud ‘ e

& Choose File df, doc, docx, xis, xbex, g 7 3 & dag

LITTLE ROCK
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ACTION: POSTING BIDS

STEP 1: POSTING BIDS

Publishing your bid posts your bid to the “Current Solicitations” page which is viewable by the public at
http://Irwravendorportal.com/vendor-portal/solicitations/ .

You have four options under the dropdown menu for “Publish:”

< > C ‘(D Not secure | Irwravendorportal.com/login/page/edit/?id=1275
Bid Opportunity 123

Email Message *

Normal ~ | Styles ~|B I |T |k 2| & ™ EMm=EQ @ @) % [ source

We are pleased to announce this bid opportunity

body p

I Documents

2 adding_new_bids_step.png 84 kB

Description

Your bid

& Choose File pdf, doc, docx, xls, xIsx, gif, jpg, jpeg, png

Publish v Save + Keep Unpublished = v

% Publish + Exit
@ Publish + View
© Publish + Add New

2©2018
Z Publish + Next

LITTLE ROCK

Water Reclamation
t J Authority exe vt




“Publish + Exit”: publishes the bid to the “Current Solicitations” page and returns you to the
Administrators’ Homepage, where your bid will be listed.

& (] ‘ ® Irwravendorportal.com/login/page/?login=1

(p) PrOCESSWITre
B Pages v @ Irwra - Successful login
Find
Recent PageS
o' Access o)
[Z Export Vendors Vendor Portal & 1
Site Map
4+
Search
Fest4

“Publish + View”: publishes the bid to the “Current Solicitations” page and takes you to that page to
view the posting.

SOLICITATIONS e e 5 &  HELPFULLINKS

Edit Profile »
LRWRA-18-002 EQUIPMENT TRAILERS (SMALL) e ;
Submission Deadline: 2:00 pm, Mar 1, 2018 -

LRWRA-18-001 GAS LEAK DETECTION SENSORS
Submission Deadline: 2:30 pm, Mar 6, 2018

LITTLE ROCK
t J Water Reclamatlon



“Publish + Add New”: publishes the bid to the “Current Solicitations” page and takes you the “Add
New” page to enter in another bid.

< C | ® Not secure | Irwravendorportal.com, « O

(P ProcESSWire

o Add New E3

Recent
Solicitation
& Access Title *
Export Vendor
Name & Ok *

“Publish + Next”: publishes the bid and allows you to see the next bid by date prior to your bid in
the administrators’ screen.

&« C | ® Not secure | Irwravendorportal.com ~ o
(P) ProcESSWITE
Tree &
Find Test m Save + Keep Unpublished  ~
nc
Recent
Conter
& Access
Solicitation Name * Publish From Date * Publish Until Date *
) Test 2 February 23, 2018 -
Opening Date * Bid Type * Contact "
February 23 2018 7:56 pm Bid v
Categories
Subject Line *
Email Message *
s B I|LliE |- PFREEQE E Y B suce
LITTLE ROCK

Water Reclamation
J Authority sx wevss:.



ACTION: SAVING BIDS AS UNPUBLISHED

STEP 1: SAVING BIDS AS UNPUBLISHED

“Save + Keep Unpublished” allows you to completely enter a bid into the system without allowing it
to be available for public viewing. This action also offers four options:

& > C | ® Notsecure | Irwravendorportal.com/login/page/edit/?id=1275
Bid Opportunity 123

Email Message *

Normal ~ | styles ~|B I |Z 9 | e ™ M= Q@ @ % @ source

We are pleased to announce this bid opportunity

body p

I Documents

adding_new_bids_step.png 84 kB

Description
Your bid

B> Choose File pdf, doc, docx, XIs, xlsx, gif, jpg, jpeg, png
Save + Keep Unpublished v

x Save + Keep Unpublished + Exit
@ Save + Keep Unpublished + View

© Save + Keep Unpublished + Add New
ProcessWire 3

7 Save + Keep Unpublished + Next

“Save + Keep Unpublished + Exit”: Saves the bid and allows it to stay visible only by administrators with
login access and returns you to the Administrators Homepage. It does not post your bid to the “Current
Solicitations” page.

“Save + Keep Unpublished + View”: saves the bid and allows you to review the document in
administrators’ screens only. It does not post your bid to the “Current Solicitations” page.

“Save + Keep Unpublished + Add New”: saves the bid and returns you to the “Add New” screen in the
administrator’s pages and allows you to enter in another bid. It does not post your bid to the “Current
Solicitations” page.

“Save + Keep Unpublished + Next”: saves the bid and takes you to the page to edit/review the last bid
created (published or unpublished). It does not post your bid to the “Current Solicitations” page.

LITTLE ROCK
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ACTION: SENDING BIDS TO REGISTERED VENDORS

STEP 1: SENDING BIDS TO REGISTERED VENDORS

Login from the administrators’ page. You must be logged in as an administrator to send bids.

&« > C @ Not secure | Irwravendorportal.com/login/page/?open=1

@ PROCESSWIire

Admin Login

Username Password

© Forgot your password?
#& Home

LITTLE ROCK
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STEP 2: SENDING BIDS TO REGISTERED VENDORS

Next, access the “Current Solicitations” page via the “View” tab.

& C  ® Irwravendorportal.com/ login/page/?login=1
(P) PROCESSWIre
E; Pages v @ Inwra - Successful login
Admin >
Find
Recent Pages
= - Home 5 New
Export Vendors Vendor Portal & 1
Site Map
Search

STEP 3: SENDING BIDS TO REGISTERED VENDORS

This will redirect you to the “Current Solicitations” page. Click on the “View” button to the right of the
bid you want to send to all vendors who are registered under the categories assigned to this bid.

(= C | @ Irwravendorportal.com/vendor-portal/solicitatior %@

CURRENT SOLIGITATIONS

SOLICITATIONS i e &  HELPFULLINKS
Edit Profile 4

LRWRA-18-004 COMMERCIAL INSURANCE BROKER A s :

EE submission Deadiine: 2:00 pm, Feb 8 s

LRWRA-18-002 EQUIPMENT TRAILERS (SMALL)

IEE] submission Deadline: 200 pm, Mar 1,2018

LRWRA-18-001 GAS LEAK DETECTION SENSORS
m Submission Deadline: 230 pm, Mar 6, 2018

LITTLE ROCK
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\ J Water Reclamahon

STEP 3: SENDING BIDS TO REGISTERED VENDORS

Clicking “View” will bring up a screen with all documents attached to the accessed bid. In the side bar to
the right, click on “Send To Vendors.” This action will send the bid to vendors who are registered in one
or more of the categories assigned to the accessed bid.

&«

LRWRA-18-004 CUMMERClAl |NSURANCE BROKER ®  HELPFULLINKS

Submission Deadline: 200 pm, Feb 23,2018 @ procuremean Edit Profile »
LRWRA Main Site »

DOCUMENTS

LRWRA-18 004 Commercial Insurance Broker 75 | SIERRaCopy

B SEND TO VENDORS

LITTLE ROCK




ACTION: EDITING PUBLISHED BIDS

STEP 1: EDITING PUBLISHED BIDS

To edit published bids navigate to the Administrators’ Homepage and click “Vendor Portal.”

[ Pages « ProcessWire « In X e = X
& > C | ® Inwravendorportal.com/login/page/?login=1 ¥
(P) PrROCESSWITE =
Pages Adm
Find Pages
Recent
Home 6 View New
Access Vendor Portal 4'/_
Users Site
Export Vendors o
Fest+
Fest

& Profle O Logout

This will reveal the button “Solicitations.”

[ Pages « ProcessWire « I X e - X
& > C | ® Inwravendorportal.com/log e 4
(P) PROCESSWITE =
Pages
Find Pages
Recent
Home 6
Access Vendor Portal View New
Users Solicitations » ——
Export Vendors o
Test4
Fest

ProcessWire 3.0.62 © 2018 & Profile  ® Logout

LITTLE ROCK .
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STEP TWO: EDITING PUBLISHED BID

Click “Solicitations.” This will reveal the options “Bids,” “RFPs” and “RFQs.” If any bids have been posted
under one of these categories, a number next to the category will detail how many have been published
(whether or not they are still active). In the example below there are 4 Bids, no RFPs and 1 RFQ.

[ Pages « ProcessWire « In X e = a X
€& > C | ® Irwravendorportal.com/login/page/?login=1 w B
(P) PrROCESSWITE =
Pages
Find Pages
Recent
Home
Access Vendor Portal
Users Solicitations
Bids 4 4——/
Export Vendors
RFPs 4,_/
RFQs 1 ———
Festt
Fest
& Profle  ®Logout

To edit a published post under the categories “Bid,” “RFPs” or RFQs” click the button under which the
bid you would like to edit is housed.

LITTLE ROCK

Water Reclamation
J Authority sx wevss:.



This will reveal a list of all bids under that category. Bids with lines through them are no longer
published and viewable to vendors.

[ Pages « ProcessWire » Ir X e -
& - C | ® Irwravendorportal.com/login/page/?login=1 h* g
Find Pages
Recent
Home 6
= Access E Vendor Portal 1
Users Solicitations
Bids 4
Export Vendors
AFWRF Parallel Treatment
LRWRA-18-001 Gas Leak Detection Sensors
LRWRA-18-002-Equipment Trailers{Small)
LRWRA-18-019 Push Cameras and Monitor/Control Boxes
RFPs
RFQs 1
Fest4
Fest

To edit a bid hover over the name of the bid. A menu will appear to the side, giving you the options
“Edit,” “View” or “Move.” Click “Edit.”

[) Pages « ProcessWire « In. X (2] -

& > C | ® Irwravendorportal.com/login/page/?login=1 Y

Find Pages

Recent
Home 6

= Access Vendor Portal 1
Users Solicitations
Bids 4

Export Vendors
AFWRF Parallel Treatment » Edit View Move >
LRWRA-18-001 Gas Leak Detection Sensors
LRWRA-18-002 Equipment Trallers{Smalh
LRWRA-18-019 Push Cameras and Monitor/Control Boxes

RFPs

RFQs 1

Inwravendorportal.com/login/page/Zlogin=12

LITTLE ROCK
Water Reclamatlon
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Once you click “Edit” you will be sent to the same screen as when you initially added the bid, except this
page will have all of the information which was published with the bid.

(P) ProcESSWITe

B Pages v tal > Solicitations > Bids >
5 AFWRF Parallel Treatment E
Recent

Content Settings Delete View v
= Access v

Solicitation Name * Publish From Date * Publish Until Date *
= Epart Vendors AFWRF Parallel Treatment February 12, 2018 & April 3, 2018

Opening Date * Bid Type * Contact *

March 13, 2018 2:00 pm Bid v

cary.lipscomb@Irwra.com

Categories v
v
+ Construction Services: Other Construction Services Not Listed L}

Subject Line *

AFWRF Parallel Treatment - Invitation to Bid

To change any of the information, follow the same steps as listed in the “Adding Bids” section of this
instructional booklet.

If you plan to resend this bid to registered vendors, it is highly suggested you add the phrase “Edited
mm/dd/yy” to the beginning of the “Email Message.”

[ Edit Page: AFWRF Paralle X

e - X
& C | ® Irwravendorportal.com/login/page/edit/?id=1040 v B
v -
+ Construction Services: Other Construction Services Not Listed o
Subject Line * v
AFWRF Parallel Treatment - Invitation to Bid
Email Message * v
Format ~ | styles B I |%|E =|9|e ™ @M= Q@ G % [ Source
AFWRF Parallel Treatment - Invitation to Bid
i Documents v
[A invitation_to_bid-1.pdf 84 kB o
Description
Invitation to Bid PDF
= Chooce File odf doc. docx. xIs. xIsx. aif. ipa. ipea. pna & drag and drop files in here e

LITTLE ROCK
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Once all of your changes have been made, click “Save.”

[ Edit Page: AFWRF Parall: X e - X
€< C | ® Inwravendorportal.com/login/page/edit/?id=1040 w B

Format -~ | Styles ~-|B I |L | = [~ & @ (@ | %~ | [ Source -

i
o)

AFWRF Parallel Treatment - Invitation to Bid

i Documents

[ invitation_to_bid-1.pdf 84 kB @

Description

Invitation to Bid PDF

&= Choose File pdf, doc, docx, xis, xisx, gif, jpg, jpeg, png & drag and drop files in here

sWire 3.0.62 © 2018 & Profile  ® Logout

Description
® Save + Exit n to Bid PDF
@ Save + View
© Save +Add New se File pdf, doc, dc
& Save + Next
Save v

“Save + Exit”: Saves the bid and returns you to the Administrators Homepage.
“Save + View”: Saves the bid and allows you to review the post.

“Save + Add New”: Saves the bid and returns you to the “Add New” screen in the administrator’s pages and allows
you to enter in another bid.

“Save + Next”: Saves the bid and takes you to the page to edit/review the last bid created (published or
unpublished).

Saving your bid will not automatically email registered vendors with your edits. To do this you must follow the
steps for Sending Bids to Registered Vendors listed previously in this instructional booklet.
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ACTION: VIEWING AND EXPORTING VENDOR
REGISTRATIONS

STEP 1: VIEWING AND EXPORTING VENDOR REGISTRATIONS

From the Administrator’s Homepage, click on the “Export Vendors” tab located in the side bar.

(P) PrROCESSWITre

Pages
Find Pages
Recent

Home 6

ARLESS " Vendor Portal

% Export Vendors =i
Fest+

STEP 2: VIEWING AND EXPORTING VENDOR REGISTRATIONS

This will take you to the following page, where you will click on the link “Download Vendors CSV.”

& C | ® Irwravendorportal.com/login/export-vendors/
(P) PROCESSWITe =
Pages Admin
Access

Export Vendors

B Export Vendors
Download Vendors CSV €———
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STEP 3: VIEWING AND EXPORTING VENDOR REGISTRATIONS

Clicking the above link will download an Excel file containing vendor registration. Open this file to access

vendor data.

—

C | ® Irwravendorportal.com/login/export-vendors/

(P) PrROCESSWITre

g

1 Pages

(' Access

B Export Vendors

vendors

(1).csv

Export Vendors

Download Vendors CSV

W
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ACTION: ADDING VENDOR CATEGORIES

STEP 1: ADDING VENDOR CATEGORIES

Click on ‘Fields’ under the ‘Setup’ menu (on the left).

(@) Processwire

B Pages
Sy ields
e

Y Filters

#' Access

Dport Whdors ® dynamic-se lect

% Untagged
NAME LaneL Tvrr TEMPLATES
bid_body Description Textarea 1 5
bid_contact Contact Emall 1 *
bid_deadline Opening Date ODatetime 1 *
bid_documents [ Documants File 1
bid_subjectiine Subject Lina Text 1 W
bid_type Bid Type Options 1 *
body Body Toxtarea
headline Headiine Text 0

STEP 2: ADDING VENDOR CATEGORIES

Scroll down near the bottom of the list. Only click on the button titled
‘vp_categories.’ This option is closer to the bottom of the list. Do not click any
other fields, as they impact the backend construction of the site.

sidebar SioeDy lextarea

summary Summary Textarea 1 -

title Title PageTitie 12 b5 Qe

vp_address Address Text 1 *

vp_address2 Address 2 Text 1

vp business Company Name Toxt 1 *

vp_catogories ‘\ Categories Options

vp_city City Toxt 1 *

vp_consent | agree to recesve emalls from Uittle Rock Water Reclamation Checkbox 1 *
Authority,

vp_omail Aternatve E-Mad Address Emall 1

vp ext Ext Integer

vp_fax Fax Text 1

vp_lirstname First Name Toxt 1 #

vp_jobtitie Job Titla Text 1

vp lastname Last Name Text 1 *

vp_minority Minority Business Options 1 *

yn_mahils Mahilp Phone Teyt 1
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STEP 3: ADDING VENDOR CATEGORIES

After clicking ‘vp_categories’ you will be redirected to the below page. Click on the tab

labeled ‘Details.’

I Pages
Setup N . .
Edit Field: vp_categories
Basics Details Input Access Advanced Actions Delete
# Access
Name *
Export Vendors

vp_categories

Type *
Select Options 3

Label
Categocies
Description
Notes
| Save

(p) Processwire. & .

Override by template ¢

STEP 4: ADDING VENDOR CATEGORIES

Add the category using the same format as the existing categories. Do not add or

change the numbers.

The website/program should add the numbers automatically upon saving. Only add the
new category where it should fall alphabetically, and click save. The numbers may get
out of order, but only the computer will use these for outputting the categories by

selection.

() ProcESSWITE ‘ :

i Pages Ad Setup > Field
Setup & . ‘
Edit Field: vp_categories
Basics Details Input Access Advanced Actions Delete
Access

What should be used for input?
Export Vendors
D at input type you choose, the user will be able to select either a single option o

AsmSelect (Multiple values)

What are the selectable options?

11D nur will be assigned to each of y¢

1=Advertising, Communications, and Media Related Services: Advertising, Communications, and Media Related Services
2=Advertising, Communications, and Media Related Services: Other Related Items and/or Services Not Listed

3-Audi and Supplies: and Supplies

4=Automotive Parts and Supplies, and Shop Equipment and Supplies: Automotive Parts, Supplies, and Accessories
5-Automotive Parts and Supplies, and Shop Equipment and Supplies: Automotive Shop Equipment and Supplies
B=Automotive Parts and Supplies, and Shop Equipment and Supplies: Tires and Tubes

7=Automotive Parts and Supplies, and Shop Equipment and Supplies: Utility Beds

8=Automotive Services and Repairs: Repair Services

9=Automotive Services and Repairs: Towing Services

10=Automotive Services and Repairs: Overhaul Service

- > E3

Override by template ¥

bur instructions for using this field
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ACTION: EDITING VENDOR PROFILES

STEP 1: EDITING VENDOR PROFILES

Click ‘Users’ under ‘Access’ on the left menu. Select the user you wish to edit. This will take you

to the vendor’s profile.

I Pages v Admin » Access
/ Setup
Users o |
= Modules v
Filters. Columns = 2
« Access v
@ What pages to show ..
Roles
Permissions 1t0250f38 - 2 New
Expont Vendors USERNAME E-MAIL ADDRESS ROLES
badams-thompsonpipegroup.com badams@thompsonpipegroup.com vendor, guest
Dynamic Selects
best-bestprinting.com best@bestprinting.com vendor, guest
bidsandproposals- nomadges.com bidsancproRosaIENOMALESS.CoM vendor, guest
bpropertymilc-gmail.com bpropertymic@gmad com vendor, guest
brent.jacksonar-yahoo.com brent jacksonar@yahoo.com vendor, guest
‘cgreena-bommaritoconstruction.com cgreene@bommariioconstruction.com vendor, guest
charliep-pulsair.com charliep@pulsair com vendor, guest
csalese-mail.theblusbook.com csalese@mal theblusbook com vendor, guest
cwitcher-chstout.com cwitcher@chstout.com vendor, guest
davidellett-brhgarver.com davidellett@brhgarver.com vendor, guest
dbei-sstelco.com dbeitssteico.com vendor, guest
dDoggs-arkonecall.com dboggsGarkonecall.com vendor, guest
derrickdean-dddleasing.com dermckdean@dddioasing com vendor, guest
Aensfinmrienasnes droche@orcotan.com vendor, guest
LITTLE ROCK
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STEP 2: EDITING VENDOR PROFILES

Change the desired profile information.

£ Pages v Admin > Access > Users
¢ Setup F
badams-thompsonpipegroup.com m
= Modules v
Content  Delete
« Access v
Users ™ » Username *
Roles Any combination of letters (a-z), numbers (0-8), dashes or underscores (no spaces).
Permissions badams-thompsonpipegroup.com =
Export Vendors First Name * Last Name *
Dynamic Selects Brent Adams
E-Mail Address Alternative E-Mail Address
badams@thompsonpipegroup.com
Company Name Job Title
Thompson Pipe Group - Flowtite
Address * Address 2
18585 Samuels Road
City * State * Zip Code *
Louisiana B 70791
Phone Ext. Mobile Phone Fax
8167399582 8167399582 123-456-7890
STEP 3: EDITING VENDOR PROFILES
Click save.
£ Pages - Admin > Access > Users
* Setup §
badams-thompsonpipegroup.com m
= Modules v
Content  Delete
«' Access v
Users ™ » Username *
Roles Any combination of letters (a-z), numbers (0-8), dashes or underscores (no spaces)
Permissions. badams-thompsonpipegroup.com ]
Export Vendors First Name * Last Name *
Dynamic Selects Brent Adams
E-Mail Address Alternative E-Mail Address
badams@thompsonpipegroup.com
Company Name Job Title
Thompson Pipe Group - Flowtite
Address * Address 2
18585 Samueis Road
City * State Zip Code *
- | auisiana : 2o
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